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What Actions
Are Made Of

Doesn’t it always seem as if there are more tasks

to perform during the day than the hours will

allow? I find myself in this situation regularly.

Such is the life I’ve chosen; if I’m not in front of

my computer, the bills don’t get paid. If there

were a way to automate day-to-day tasks, I could

focus on the important work or be off enjoying

my family. Fortunately, Adobe created actions,

which allow busy Photoshop and ImageReady

users to record the steps of a task for replay later.

Complete a task successfully once, and the soft-

ware can duplicate those steps on another image

or group of images. Now that’s what I call living!1
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Why Automate?

Why should you automate? The primary reason comes down to the old axiom from
Poor Richard’s Almanac (written by Benjamin Franklin, for those keeping score): time
is money. Say you have 1500 photos that need a simple levels adjustment or batch
resizing to thumbnails. Tackling such a task could take days, regardless of how simple
the process: the sheer volume of photos needing processing requires hours upon hours
of valuable time. A Photoshop action, on the other hand, can take care of the process
in hours, and you need not be present during the work.

I will be covering the Actions palette in depth later in this chapter. Let me say
this up front: actions are far more useful than they have been given credit for. I’ve been
a champion of these little scripts for years, and in these pages I’ll demonstrate why
actions are not only cool to play with, but are powerhouses of production that will
save both time and money for the actions-savvy photographer.

What Is an Action Anyway?

I recently looked up the word action in the dictionary, and, as is usually the case with
English words, action renders at least eight separate definitions. Nearly all the defini-
tions imply an act or movement that leads to or ends in a desired result. That being the
case, the word action is appropriate when applied to Photoshop’s ability to record steps
taken within the software.

An action is, in its simplest form, a small file created by Photoshop (with input
from the user) to which the software assigns a particular extension. This extension
(.atn) simply tells Photoshop that the file is an action that the software can read and
repeat. Programmers familiar with macros will grasp the similarity right away. When
you load a prerecorded action into the Actions palette and play it, every command in
that action is carried out in the same sequence in which it was originally recorded.

An action works just like a recording. When you create an action, every Photo-
shop function you perform is added to the “tape” until you stop the recording process,
and it can then be played back and repeated without the need for the user to go
through every step again. The icons on the bottom of the Actions palette when in List
mode reflect the recording idea, as shown in Figure 1.1.

Figure 1.1 The Actions palette

in List mode, showing the Stop,

Record, and Play buttons
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Above all else, actions are time- and money-savers that, when recorded and
implemented properly, help you increase production and give you more time to pursue
other avenues or aspects of your work. They may seem intimidating to those unfamiliar
with them, but actions are easy once you get a handle on them. When you begin to see
the power of these little recordings, I’m sure you will wonder how you ever lived with-
out them.

How Will Actions Help My Work?

Actions can help in a number of ways. It doesn’t matter if you are a photographer who
wants the best resolution for your portraits or a web designer looking for continuity in
your website graphics; actions will increase your productivity. Remember, time is money.

Actions can be customized to fit particular workloads. For instance, a print house
could hire a Photoshop guru to create an entire set of Photoshop actions specific to the
needs of their business. These actions will allow the print house to batch process groups
of images to meet the preprint requirements for specific magazines and periodicals. As the
requirements change and develop, the actions can be edited accordingly. Even actions not
originally developed to the printer’s specifications (for example, third-party actions found
online or elsewhere) can be edited, customized, and resaved with the new settings.

Actions are also useful because they can be shared with others. Say you have a
friend who has developed a process in Photoshop that turns every photo it is applied to
into a Picasso. If that friend records the technique as an action, he can then give it to
you. You load it into the Actions palette on your computer, and, barring any system or
software compatibility issues, you can duplicate the effect on your own photos with a
click of a button. (See Chapter 4 for information on compatibility.)

I find one other thing about actions incredibly useful. An action is, in effect, a text
file. With the .atn extension, it cannot be viewed by a text editor; however, Adobe has
incorporated a way in which to convert an action or a group of actions to a text format.
As a result, you can make a hard copy of the entire process: every setting, every command,
every filter used to make a certain effect or adjustment can be saved as a text file, opened
in text-editing software such as Notepad, and then printed as a hard-copy tutorial for you
to use at your leisure. Keep in mind that, in order to use the actions in Photoshop, you
must save them as normal .atn files: the text files serve as informational documents only
and cannot be loaded back into the program once saved as text. Granted, you may not
need this feature for actions you create yourself, except as a reminder of how you organ-
ized the commands. But when it comes to actions you’ve gathered from other sources, this

N o t e : An action is a series of recorded commands that can be played back in Photoshop on a single file or

a group of files.
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is a powerful feature, because it allows you to view all the commands and settings used.
This is an excellent learning tool that will be covered in Chapter 4. Once you have the
process down, you can save any action on the CD included with this book as a text file
and print it for your training library. Talk about double the bang for your buck!

What Can an Action Record?

Actions are extremely versatile in that they allow you to record almost everything—I
repeat, almost. Not all settings, commands, and tools can be recorded, but you can
work around these limitations. Actions are so versatile, in fact, that you can record
steps into actions in many ways. You can use the menus, or, if you are savvy with key-
board shortcuts, you can record with these.

Table 1.1 is a neat list of which tools can and cannot be recorded with actions.

� Table 1.1 Action-able Status of Photoshop Tools

Can Be Recorded Can’t Be Recorded

Audio Annotation Blur, Sharpen, Smudge

Color Sampler Clone Stamp, Pattern Stamp

Crop Dodge, Burn

Eyedropper Eraser, Background Eraser

Gradient Healing, Patch, Color Replacement

Lasso History Brush, Art History Brush

Magic Eraser Paintbrush

Magic Wand Path Selection, Direct Selection

Marquee Pen

Move Pencil

Note Zoom

Paint Bucket

Polygon

Shape

Slice

Type

N o t e : Photoshop does not recognize some keyboard shortcuts on an operating system other than the one

on which the action is recorded. If you intend for your actions to play on both Windows and Macintosh, using

the File menus is the way to go.
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Basically, any tool that requires you to paint, manually select, erase, or alter the
image/layer with the mouse cannot be recorded; you must still perform most of these
functions manually.

That said, in one situation you can apply paint with the action. If, for instance,
you create a path or a path from a selection, you can stroke the path with a Paintbrush
so that the paint is applied along the path. As mentioned, there is usually a
workaround for things that “can’t” be done with actions: you may need to use a little
intuition to find it. An action is only as intelligent or complex as the creator makes it:
the firmer your grasp on how the software works, the more functionality you can
squeeze from actions.

Modal Tools and Operations

Some tools and commands in Photoshop are modal in nature. That is, they use units specified for
the ruler to judge where in an image an operation should take place or tool function be applied.
Modal tools and operations typically require you to press Enter (Windows) or Return (Mac) to
accept the change or setting; transformations using the Transform commands are good examples
of this.

If your action will be run on images of different size or dimension, change the ruler units to per-
cent before recording the action. When you do so, the modal-specific commands in the action play
back in the same general area in each image.

You can record most operations and filters in actions, as well as settings and
commands from within palettes. For instance, while recording an action, you can select
another action to be played; I’ll cover this topic in Chapter 3.

For those commands that cannot be recorded (painting and toning, option set-
tings for tools, view and window commands), you can use the Insert Menu Item com-
mand. In effect, this stops the action and lets you perform the nonrecordable function.
Spell-check is a good example of this; user input is required in this instance, and Photo-
shop won’t know which version of there, their, or they’re you want. Again, this will be
covered in depth later.

One other item will help you when developing actions: a Stop. A Stop lets you
insert messages into the action so that while the action is replaying, you can tell the
user to perform certain functions that are otherwise nonrecordable, tell them to change
or apply text, or simply give them information about the action. You can even adver-
tise your website, leave your e-mail, or give out any other information you would like.
Another excellent use for a Stop is a personal note to help you remember what you
were doing at a certain point.
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What Would I Automate? Why Should I Automate?

Since Photoshop allows you to automate nearly every function in the software, this is a
difficult question to answer. Repetitive tasks that you perform frequently without
adjustment to settings are clear candidates for actions. Resizing, image quality tech-
niques, preparing items for display online or in print, creating text styles for water-
marks, cropping, rotating, and applying filters are all good contenders.

Ultimately, the question of what you should or should not automate is up to
you. You know better than I which commands you use frequently and at what setting.
Some people record actions for the simplest functions; some create them for techniques
that are extremely advanced and time-consuming.

For instance, let’s take a quick look at keyboard shortcut combinations. Key-
board shortcuts let you select and apply/reapply tools or settings and are intended to be
easy, correct? The problem is that there are so many keyboard shortcuts it is difficult to
remember a fraction of them! You recall the ones you use frequently, but those you use
less frequently are long forgotten or hard to track down.

Case in point: let’s say you want to rerun the Transform command with dupli-
cate data from the original layer. The Windows shortcut keys are Ctrl+Shift+Alt+T; on
a Mac, they are Command+Shift+Option+T. It is almost more difficult to use the short-
cut than it is to simply run the desired process from the Edit menu. In some cases, the
shortcut combinations are so complex my fingers have a hard time reaching all the
keys.

In Photoshop CS, you can now change and customize your keyboard shortcuts,
and this is great, provided no other commands are already assigned to that shortcut.
With so many keyboard combinations already assigned, this is difficult to say the least.
With an action, however, you can record the setting and assign a new shortcut key
combination. You can then either click Play and run the action or press the new key
combination. You can assign a shortcut to an action that simply attaches it to a func-
tion key (F1, F2, and so on) or combines a function key with Shift, Command/Ctrl, or
both, allowing for 60 keyboard shortcuts that can be assigned to actions.

What should you automate and why? Anything that will save you time in the
long run, whether tool shortcuts or extended image-processing techniques. After a
while you will know what works best for your situation and what will benefit your
work most. Actions are for your benefit; use them to your advantage.

The Actions Palette

You control and manage Photoshop actions using the Actions palette (see Figure 1.2).
You use this palette to play, record, edit, and delete individual actions, as well as load
saved action sets.
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Figure 1.2 The Actions palette

You can access the Actions palette in two ways: choose Window > Actions, or
use the Windows shortcut key combination Alt+F9. If the palette is visible but not
active (docked with other palettes or resident in the Palette Well), simply click the
Actions tab to bring it to the foreground.

After an overview of palette modes and the Actions palette menu, this chapter
will move into the body of the Actions palette itself, breaking down and describing
each item in the palette while in List mode.

Actions Palette Modes

The Actions palette has two modes or states: Button and List. This chapter primarily
focuses on List mode, as you can do a lot more when the palette is in that state. Before
getting into List mode, Button mode warrants a glance.

Button mode displays all the actions loaded into the palette as color-coded but-
tons; the colors are assigned by the action’s creator. In Button mode, you cannot edit the
action; you are given the option of running the action only by clicking the button. Fig-
ure 1.3 shows the Actions palette in Button mode, with Adobe’s default actions loaded.

Note: Photoshop actions can be saved only in action sets.A set can contain one or more actions. ImageReady

does not allow you to group actions together in sets; Photoshop gives you this option so that your actions can be

better organized.

Modal Control

Action set
Action

Command

Toggle On/Off

4334c01.qxd  6/18/04  7:30 PM  Page 7

























19

■
 B

A
T

C
H

 P
R

O
C

E
S

S
IN

G
 A

N
D

 D
R

O
P

L
E

T
S

� Table 1.2 Continued Keyboard Shortcuts for the Actions Palette 

Result Windows Mac OS

Double-click set or actions.
Alt+double-click set or action in
ImageReady

Play the entire action. Ctrl+double-click an action. Command+double-click an action.

Alt+click the triangle. Option+click the triangle.

Ctrl+click the Play button. Command+click the Play button.

Alt+click the New Action button. Option+click the New Action 
button.

Shift+click the action/command. Shift+click the action/command.

Ctrl+click the action/command. Command+click the action/
command.

If you want to set up your own shortcuts, choose Edit > Keyboard Shortcuts and
assign your own combinations manually. Bear in mind that Photoshop already uses
hundreds of shortcuts, so it may be difficult to find combinations that are not in use.

Batch Processing and Droplets

Using actions to process multiple images for a specific result will be covered in depth 
in Chapter 3, but it is important to understand the relationship between actions, the
Batch command, and droplets. Actions can be run independent of the Batch command
or droplets, but the Batch command and droplets require actions.

These three elements work together to give you control over the editing or cor-
rection of multiple images, refining your workload and saving incredible amounts of
time if used together correctly. The Batch command and droplets, although similar, are
two separate entities; they are placed together here for readability.

Select noncontiguous items of
the same kind. (Select two or
more action sets, two or more
actions, two or more com-
mands, etc.)

Select contiguous items of the
same kind. (Select two or more
action sets, two or more actions,
two or more commands, etc.)

Create a new action and begin
recording without confirmation.
(This simply prevents the dialog
box from appearing, creating a new
action with Record turned on.)

Play a single command in
an action.

Collapse/expand all components
of an action so that the com-
mands and settings can be
viewed in the palette.

Double-click set or actions.
Alt+double-click set or action
in ImageReady.

Displays the Set or Action
Options dialog box.
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I have covered actions, at least on an introductory level, so let me briefly explain
batch processing and droplets.

The Batch Command

The Batch command lets you play an action on a folder of images or on groups of fold-
ers. You can also use the Batch command to import and process images from other
sources, such as scanners and digital cameras with action-compatible plug-in modules,
and you can import PDF images from capture software programs such as Adobe Acro-
bat Capture.

The power of Photoshop actions, for a photographer, actually resides in the
Batch command. Batch processing lets you correct multiple images while taking care of
other tasks, leaving Photoshop to process and save the selected files without user input.
You can even leave Photoshop to do the work while you’re at home sleeping; when you
return to work the next day, you can rest assured, if everything performed properly,
that all 1500 images have been corrected, resized, and saved to a new folder with the
originals intact, for one example. Chapter 3 covers batch processing in depth.

Droplets

Droplets are similar in operation to the Batch command, but are distinguished from the
former in that droplets are actually small applications. A droplet has its own icon that
can be saved to a folder or to the desktop. You can then drag an image file or a folder
of images to the icon, and Photoshop will open (if it isn’t already) and process each
image in the folder. Although a droplet is an application, it cannot process images inde-
pendently of Photoshop. Droplets will be covered in depth in Chapter 3.
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